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Lightroom Classic is a folder-based image 
management and editing program designed 
especially for photographers. It guides 
you through your workflow, including 
organizing, editing, and sharing your digital 
images and videos.

It’s designed around a database, rather 
than a file browser, so it keeps a record of 
the photos even when the original files are 
offline. This makes it quick to search and 
find photos.

Lightroom’s Develop module is a non-
destructive, parametric editor. This simply 
means that your edits are saved as metadata 
(text instructions), rather than being applied 
to the pixels themselves, so it doesn’t 
degrade the original image data. You can 
experiment without fear.

To save writing it’s full name—Adobe 
Photoshop Lightroom Classic—over and over 
again, we’ll refer to it as Lightroom in this 
book.

LIGHTROOM CLASSIC VS. 
LIGHTROOM (CLOUD-BASED)

In October 2017, Adobe announced that 
Lightroom was dividing in two different 
directions, so that each program can 
focus on its strengths. Lightroom Classic 
continues the desktop folder-based 

workflow we’ve used for the last 10 years, 
whereas the Lightroom cloud-based 
eco-system (formerly Lighroom CC) is 
cloud-native, so all of your photos are stored 
in the cloud and accessible from any device. 
You can learn more about Lightroom cloud 
eco-system in another of my books, Adobe 
Photoshop Lightroom - Edit Like a Pro.

If you’re still trying to figure out which 
version you need, this blog post will 
help: https://www.lightroomqueen.com/
lightroom-cc-vs-classic-features/

Lightroom Classic and Lightroom (cloud-
based) are like distant cousins, so their 
communication is limited. You’ll find 
detailed information about these limitations 
in my main Adobe Lightroom Classic - The 
Missing FAQ book.

THIS BOOK

This Quick Start eBook is designed to guide 
you through a simple Lightroom workflow. 
It’ll give you a taste of what Lightroom can 
do, and help you to feel comfortable using 
Lightroom to manage your photos, while 
avoiding the most frequent problems.

We’re not going to cover every tool, button, 
slider and checkbox, and we’re not going to 
cover all the possible variations in workflow. 
If we did, it would fill hundreds of pages and 
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https://www.lightroomqueen.com/shop/adobe-lightroom-cc-edit-pro/
https://www.lightroomqueen.com/shop/adobe-lightroom-cc-edit-pro/
https://www.lightroomqueen.com/lightroom-cc-vs-classic-features/
https://www.lightroomqueen.com/lightroom-cc-vs-classic-features/
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then it wouldn’t be a quick start guide!

You’ll find more detailed information 
about Lightroom Classic in my main 
book, Adobe Photoshop Lightroom 
Classic - The Missing FAQ, available from 
https://www.lightroomqueen.com and 
online bookstores. I hope you find the 
information useful. Now let’s get started...

https://www.lightroomqueen.com
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Just in case you haven’t installed Lightroom 
Classic yet, we’ll briefly run through the 
installation procedure. If you’re already up 
and running, you can move on to the next 
chapter.

If you already have a subscription, click on 
the Creative Cloud icon in the System Tray 
(Windows) / Menubar (Mac) and select the 
Apps tab. Scroll down to Lightroom Classic 
and press Install. (Figure 1)

INSTALLING 
LIGHTROOM 2

Show menu

Apps tab

Install app

Update app

Uninstall app

Open app

Show app menu

Check for Updates

Creative Cloud app 

Preferences

Figure 1   The Creative Cloud Desktop app allows you to easily install and update Adobe software.

If you don’t have the Creative Cloud 
desktop app installed, log in to your account 
at https://www.adobe.com and select 
the Desktop Apps from the menu. Find 
Lightroom Classic and click the Download 
button. It prompts you to install the Creative 
Cloud desktop app, and then you can follow 
the previous instructions.

To download a trial of Lightroom Classic, 
visit https://creative.adobe.com/products/
download/lightroom-classic

https://www.adobe.com
https://www.lightroomqueen.com/classictrial
https://www.lightroomqueen.com/classictrial
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Before you start importing your photos into 
Lightroom, you have a couple of decisions 
to make Making them now will save a lot of 
unnecessary work later.

First, you need to decide where to store 
your catalog and photos on your computer. 
And then it’s useful, but not essential, to 
decide on your folder structure and file 
naming.

WHERE WILL YOU STORE 
YOUR CATALOG?

Because Lightroom is a non-destructive 
editor and cataloging program, all of the 
information about your photos and the 
changes you’ve made within Lightroom are 
stored in Lightroom’s catalog.

When you first start Lightroom, it asks 
where to store the catalog and how to name 
it. (Figure 2) By default, the catalog is called 

WHAT IS A CATALOG?

All of the information about your 
photos is stored as text in a database. 
This is called a Lightroom Catalog. In 
a library of books, the library catalog 
doesn’t contain the books themselves, 
but a record of where to find each book 
and information about it. Similarly, 
Lightroom’s catalog records where to 
find the photo on the hard drive and 
stores information about that photo, 
but it doesn’t contain the photo itself. 
Lightroom also keeps small previews of 
the photos, like a library catalog may 
keep a photo of the book’s cover.

Figure 2   Lightroom asks where to store your new Lightroom catalog.

BEFORE YOU START 3

Lightroom Catalog.lrcat and it’s stored in 
your main Pictures folder. 

Next to the catalog, Lightroom creates 
a Previews folder (Windows) / file (Mac) 
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called Lightroom Catalog Previews.lrdata. 
The previews folder/file contains a small 
JPEG preview of all the photos you import 
so it can grow very large.

If you have plenty of space on your boot 
drive (usually C:\ on Windows or Macintosh 
HD on Mac), click Continue to select the 
default location.

If your boot drive’s low on space or you’d 
prefer an alternative location for your 
catalog, click Choose a Different Destination 
and select your chosen folder and catalog 
name. (The catalog must be stored on an 
internal or external hard drive, not network 
storage.)

Either way, make a note of the catalog name 
and location you choose, as you’ll need to 
ensure these files are backed up.

WHERE WILL YOU STORE 
YOUR PHOTOS?

Lightroom doesn’t hide your photos away 
from you. They’re kept as normal image 
files in folders on your hard drive, which you 
can also access using other software. We’ll 
select the location on page 8.

By default, Lightroom leaves existing photos 
in their current location and copies photos 
from cameras and memory cards into the 
Pictures folder in your user account. 

If you work on a laptop, or a desktop 
computer with a small boot drive, remember 
that your Pictures folder will fill up quickly, 
so you may want to store your photos on 
another internal drive or a mains-powered 
external drive instead of the default 
Pictures folder.

It’s best to keep all the folders of photos 
under a single parent folder (or one for 

JUST ONE CATALOG

Lightroom is designed to manage all of 
your photos in a single catalog. It can’t 
search across multiple catalogs or open 
multiple catalogs at the same time. 

Unless you have a really good reason 
for using multiple catalogs (for example, 
personal vs. work photos), try to 
stick to just one, and use folders and 
collections to separate different types 
of photography.

each drive), rather than scattering the 
photos around your hard drives. It’s easier 
to back up the photos if they’re in one or 
two locations. As your collection of photos 
grows, you can easily expand onto additional 
hard drives.

HOW WILL YOU ORGANIZE YOUR 
PHOTOS INTO FOLDERS?

Importing photos into Lightroom doesn’t 
force you to rearrange them. If you already 
have a well thought out filing system, you 
can keep your existing folder structure. As 
far as Lightroom’s concerned, your choice 
of folder structure doesn’t make a lot of 
difference. Folders are just a place to store 
the photos, and you can use metadata/
keywords to organize them. 

That said, you do need some level of 
organization to make it easy to back up your 
photos, and it’s best to avoid duplicating 
photos in multiple locations (other than as 
backups, of course). Many people choose a 
date-based folder structure, with folders for 
days (or shoots) within folders for months, 
which in turn are in folders for years.
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consistency. If you do the same thing in 
the same order every time, you reduce 
the risk of mistakes. Files won’t get lost or 
accidentally deleted, metadata won’t get 
missed, and you won’t end up redoing work 
that you’ve already completed

There is no perfect workflow for everyone, 
as everyone’s needs are different. Once 
you’ve settled on a good workflow, that isn’t 
the end of the story. You’ll likely find that 
you continue to tweak it, finding slightly 
more efficient ways of doing things. It’ll 
continue to build with time and experience, 
as well as with the introduction of new 
technology. The principles, however, remain 
the same.

HOW WILL YOU NAME 
YOUR PHOTOS?

File names direct from the camera may be 
repeated many times. For example, if your 
camera creates names like IMG_4857, 
once you’ve taken 9999 photos, it will start 
counting again at 0001. If a file doesn’t have 
a unique name, and it’s accidentally moved 
to another folder, other photos could be 
overwritten.

To avoid this situation, it’s best to make the 
filenames unique. The date and time works 
well as a unique file name, for example, 
YYYYMMDD-HHMMSS (year month day-
hour minute second). If you prefer to keep 
to the camera file name, YYYYMMDD-
original file number (and a camera code if 
you’re shooting with more than one camera) 
can work well with a low risk of duplication.

You can rename the files at any time, as long 
as you do it within Lightroom, but doing it at 
the time of import means that any backups 
you make while importing will have the 
same names as the working files.

BASIC LIGHTROOM WORKFLOW

We mentioned earlier that Lightroom 
guides you through a basic workflow, and 
we’re going to follow its lead in this eBook. 
(Figure 3) 

The term workflow simply describes a series 
of steps undertaken in the same order each 
time. For photographers, this workflow 
runs from the time of shooting (or even 
before), through transferring the photos to 
your computer, sorting and selecting your 
favorites, editing and retouching them, and 
then outputting to various formats, whether 
on screen or in print.

The initial aim for your workflow is 
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Figure 3   Each photographer’s Lightroom workflow is different, but there are similar themes.

Basic Lightroom Workflow

Capture Raw vs. JPEG

Think about your file 

format when shooting.

Output

Edit & 
Retouch

Organize

View

Import

Exposure

Expose the photo correctly in the 

camera to produce the best quality.

Import Your Photos and Videos 

into your Lightroom Catalog 

or tether your camera.

Back Up

your catalog, photos and presets.

Workspace

Navigate the Lightroom Interface.

View Your Photos

using Grid, Loupe, Survey, Compare 

modes and secondary window.

Select the Best Photos

using Ratings, Quick Develop, 

Stacks and Collections.

Manage Your Files, 

Folders and Photos by moving, 

renaming and deleting.

Add Metadata

including IPTC, Capture Time, 

Keywords, Faces and Map Locations.

Find & Filter Photos

by changing the Sort Order, 

Filters & Smart Collections.

Basic Edits

adjusting tone and color., Tone 

Curve, B&W, Split Toning, HSL 

and Effects. sharpening, noise 

reduction and lens corrections.

Selective Edits

using crop, spot removal, red eye 

reduction, graduated and radial 

filters and the adjustment brush.

Switch to Photoshop

or other external editors for 

pixel-based retouching.

Export or Email Finished Photos

in the size, format and color 

space of your choice.

Use Publish Services

to synchronize with Flickr and 

other photo sharing websites.

View Slideshows

and export them to video, 

PDF and JPEG formats.

Print

using your printer or save layouts to 

JPEG to print at a local print lab.

Create Web Galleries

to upload to your website.

Design Photo Books

and save them as PDF eBooks or 

have them printed by Blurb.
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formats that other software can understand 
(excluding Develop settings), and you can 
export the edited photos to standardized 
formats if you ever decide to switch to other 
software.

While you’re importing the photos, 
Lightroom can copy the photos to a new 
location of your choice, but that’s not 
required—if the photos are already safely 
on your hard drive, Lightroom can reference 
them at their existing location.

As Lightroom is built around a database, 
the first thing you’ll need to do is add the 
information about your photos to your 
catalog. This process is called Importing. 
Don’t let that confuse you—although it’s 
called importing, the photos don’t go ‘into’ 
Lightroom. A better word to describe the 
process might be reference, link, or register.

Just because you’re importing photos into 
Lightroom doesn’t mean you’re tied in. Your 
photos are always accessible, the metadata 
can be written to the file in standardized 

GETTING PHOTOS INTO 
LIGHTROOM 4

Figure 4   Open the Import dialog (and don’t panic, it’s not as confusing as it looks!)
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your Pictures or Photos folder, check the 
Include Subfolders checkbox. 

4.  Thumbnails start to appear in the central 
preview area. They make take a while to 
appear if you have thousands of photos. It’s 
possible to view and check/uncheck photos 
in the Import dialog, but it’s easier to sort 
through them in the Library module after 
import.

5.  At the top of the Import dialog, decide on 
your File Handling setting. (Figure 6)

If you’re importing from a hard drive, you 
have a choice: 

To leave the photos in their existing location, 
select Add, then skip to step 8. This is a good 
choice if your photos are already arranged 
in a tidy folder structure that you’d like to 
keep, but be careful that you don’t later 
delete the files thinking that they’re “in” 
Lightroom. 

To create a copy in the location of your 
choice, for example, another hard drive, 
select Copy. You’ll need twice as much hard 
drive space if you choose this option, as 
you’ll be duplicating all of your photos, but it 
leaves your current system intact.

To move the photos to a new location, for 
example, another hard drive, select Move. 
This groups your photos in a single location 
for easy backup.

If you’re importing from a memory card or 
camera/mobile device, Copy is automatically 
selected. 

THE IMPORT DIALOG

1.  Open the Import dialog by going to 
File menu > Import Photos and Videos or by 
pressing the Import button in the lower left 
corner of the Library module. (Figure 4)

2.  If you’re importing from a memory 
card, insert your memory card into the 
card reader or attach the camera to the 
computer. Card readers usually work more 
reliably with Lightroom than USB camera 
connections.

3.  In the Source panel on the left, select the 
source of the photos. (Figure 5)

In the Devices section at the top are devices 
such as memory cards, cameras and mobile 
devices.

In the Files section are folders on your hard 
drives. If you find a standard Windows or 
Mac dialog easier to use, click the large 
button above the Source panel and choose 
Other Source from the menu. If you’ve 
selected a folder with subfolders, such as 

Figure 5   Select the memory 

card in the Source panel.

Figure 6   Select Copy at the top of the dialog, 

to copy the photos to your hard drive.
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Folder in the Organize pop-up.

To create a subfolder for the photos in your 
chosen location, check Into Subfolder, enter 
the name of the new subfolder, and select 
Into One Folder in the Organize pop-up. 
This is useful when copying photos from a 
memory card into a manually-created folder 
structure.

To create a date-based folder structure 
automatically, select By Date from the 
Organize pop-up and a folder structure from 
the Date Format pop-up. If you’re not sure 
which to select, the YYYY/YYYY-MM/YYYY-
MM-DD option is a good default. 

The folders in italic preview the folder 
hierarchy that will be created by your 
import, so you can test different options to 
see what will happen. 

9.  (Optional) The rest of the settings in 
the dialog could remain at their defaults, 
however for your initial imports, I’d 
recommend the following settings. 

In the File Handling panel: (Figure 8)

Build Previews—Standard. If you’re importing 
thousands of photos, select Embedded & 
Sidecar instead. It’s quicker initially but 

6.  In the right hand panels, you decide how 
Lightroom should handle the photos as it 
imports them, including setting filenames 
and locations.

7.  If you’ve chosen Copy or Move, you need 
to choose where to store the photos using 
the Destination panel (Figure 7). By default, 
Lightroom copies your photos into the 
Pictures folder in your user account, but 
you can choose to store them on another 
hard drive by selecting it in the folder tree. 
Where did you decide to store the photos 
on page 5?

8.  Then you need to decide how you’re 
going to organize the photos. What did you 
decide on page 5? The options at the top 
of the Destination panel allow you to set the 
folder structure:

To copy/move the photos directly into the 
folder you’ve selected, select Into One 

Figure 7   Choose where to put the photos 

using the Destination panel. The folders 

in italic preview the folder hierarchy 

that will be created by your import.

Figure 8   In the File Handling 

panel, choose your preview size and 

temporary backup location.
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Renaming panel, you may leave the Rename 
Files checkbox unchecked to retain the 
current filenames or you can rename the 
photos as they’re imported. (Figure 10)

In this example, we’ll create a preset for 
a date/time based filename, but you can 
create a different filename template if you 
prefer. Check the Rename Files checkbox, 
and then in the Template pop-up, select Edit.

The Filename Template Editor dialog 
(Figure 11) allows you to create a variety of 
file naming templates using tokens. In the 
Preset pop-up at the top, select the Date-
Filename preset and then click in the white 
area below and delete the Filename token, 
retaining the Date token.

Further down the dialog, in the Additional 
section, there’s a pop-up of date/time based 
tokens. Select Hour from the pop-up and 
press Insert. Repeat for Minute and Second. 
The tokens at the top should now read Date 
(YYYYMMDD)—Hour Minute Second.

Finally, save it as a preset by selecting 
the Preset pop-up at the top of the dialog, 
choosing Save Current Settings as New Preset 
and giving it a name. Press Done to close the 
dialog, and check that your new preset is 
selected in the Template pop-up.

stores lower quality previews.

Build Smart Previews—unchecked.

Don’t Import Suspected Duplicates—checked. 
It’s not infallible but it helps avoid creating 
duplicates if you forget to reformat the card 
in the camera before shooting more photos.

Make a Second Copy To—If you’re importing 
existing photos, leave it unchecked. If you’re 
importing from a memory card, check it then 
click on the file path and choose a location 
on another hard drive as a temporary 
backup.

Add to Collection—unchecked.

In the Apply During Import panel: (Figure 9)

Develop Settings—None.

Metadata—unchecked or select New to 
open the New Metadata Preset dialog. Give 
the preset a name such as Copyright Preset 
and enter your copyright information. Only 
checked fields are saved. Press the Create 
button and your new preset is selected in 
the Metadata pop-up in the Import dialog.

Keywords—unchecked.

10.  (Optional) How did you decide to 
name your files on page 6? In the File 

Figure 9   In the Apply During Import 

panel, add your copyright metadata.

Figure 10   In the File Renaming panel, you can 

set a new file naming template, or you can leave 

it unchecked to retain the camera filename.
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11.  Finally, press Import in the bottom left 
corner of the dialog.

12.  The Import dialog closes and the 
new photos start to appear in the Library 
module. The photos are grouped in a special 
collection in the Catalog panel called Current 
Import (which then changes to Previous 
Import), and their folders also appear in the 
Folders panel.

13.  Congratulations, your photos are now 
cataloged by Lightroom! If you’re itching 
to start using Lightroom, you can now skip 
on to backing up your photos (page 13) 
and then viewing them in Lightroom (page 
20).

FILE FORMATS

Most camera raw file formats are 
supported by Lightroom. You can 
check whether your camera’s raw 
files are supported by visiting 
http://www.Lrq.me/camerasupport  If 
your camera’s newly released, you may 
need to wait for an update to support 
your camera. Lightroom can also import 
DNGs, JPEGs, TIFFs, PSD files saved 
with maximize compatibility, PNG files 
and a range of video formats.

Figure 11   If you select Edit in the File 

Renaming panel, you’ll see the Filename 

Template Editor. It uses tokens to build a 

filename structure of your choice. The date 

tokens are shown in the inset screenshot.

http://www.lrq.me/camerasupport
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Before we go any further, it’s essential 
to know how to back up your work. This 
includes your catalog, your original photos, 
and any presets and templates that you’ve 
created.

BACK UP YOUR CATALOG

Since all of the work you do in Lightroom 
is stored in your Lightroom catalog, you’ll 
need to ensure that it’s backed up regularly.

It’s a database, and while corruption is 
relatively rare, it is possible. By default, 
Lightroom prompts you to back up your 
catalog weekly. It creates a new folder 
using the current date and time as the 
folder name, and stores a zipped copy of 
the catalog in this new folder. It keeps all of 
the weekly backups, so you can ‘step back in 
time’ to an earlier version if some corruption 

occurs.

By default, Lightroom creates a Backups 
folder next to the catalog to store the 
backups. That won’t help if the drive fails, 
so change the location to another drive or 
ensure that the backups are included in your 
main system backup. You can change the 
frequency and backup location to another 
drive using the Back Up Catalog dialog.

To change the settings, open the Catalog 
Settings dialog to the General tab. Catalog 
Settings is under the Edit menu (Windows) 
/ Lightroom menu (Mac). Change the Backup 
Settings pop-up to When Lightroom next exits. 

Quit Lightroom and the Back Up Catalog 
dialog appears. (Figure 12)

Using the Back up catalog pop-up, set the 
backup frequency. If you’re working for a 

BACKUP 5

Figure 12   When the backup runs, you can change the backup location and frequency.
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KEEP VERSIONED BACKUPS

Lightroom’s catalog is just a database 
and, while comparatively rare, 
databases can become corrupted—so 
backup the catalog regularly, and keep 
older backups for a while.

restore them if there was a problem.

The Second Copy backup in the Import 
dialog simply copies the imported photos 
into folders called Imported on [date] so 
it’s great as a temporary backup while 
you ensure the photos have been safely 
added to your main backups. It won’t 
replicate your working folder structure, 
back up any additional photos such as 
those edited in Photoshop, or remove 
any photos you’ve deleted, so it’s not a 
replacement for a backup system.

The easiest way to back up your photos 
is to include them in your main system 
backups. You are running backups 
of your whole computer, aren’t you? 
Windows comes with its own Backup 
and Restore tool, and macOS comes with 
Time Machine, both of which can back up 
your computer files to an external drive. 
(Figure 13) 

few hours every day, it’s worth backing up 
daily, whereas if you only use Lightroom 
a few times each month, monthly may be 
plenty. Weekly is a good average. 

Press Choose to select a new location on 
another drive then press Back up. Leave Test 
integrity and Optimize catalog checked as 
they’re good general maintenance. 

BACK UP YOUR PHOTOS

Lightroom’s Catalog 
Backup is just that—a 
backup of your catalog. 
Your photos are not 
stored ‘in’ Lightroom 
and Lightroom’s Catalog 
Backup doesn’t back up 
the photos. Consider 
how you’re going to keep 
your photos backed up—
and how easily you could 

Figure 13  The 

Windows and Mac 

operating systems 

both come with built 

in backup tools, but 

they won’t help unless 

you enable them!
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BACK UP THE EXTRAS

Over the course of time, you’ll gather 
presets and templates that you’ve created 
or downloaded from other websites, so 
you’ll want to back these up too. You can 
manually copy them from their various 
locations, which are listed on the next page, 
or ensure that they’re included in your 
system backups.

Or, for a little more control, you can run 
dedicated backup or file synchronization 
software. Whichever option you choose, 
double check that all of your photos are 
being safely backed up, as some software 
excludes external drives by default.

BACKUP CHECKLIST

Ideally you’ll be running a full system backup, but as far as Lightroom is concerned, there are a few 

essentials to ensure you’ve included. I’ve listed the default locations, but you may have chosen 

alternative locations for some items such as the catalog. 

pp The catalog(s)—holds all the information about your photos, including all the work you’ve done 

on the photos within Lightroom.

¶¶ Windows Default—C: \ Users \ [your username] \ My Pictures \ Lightroom \ Lightroom Catalog.

lrcat

¶¶ Mac Default—Macintosh HD / Users / [your username] / Pictures / Lightroom / Lightroom 

Catalog.lrcat

Go to Edit menu (Windows) / Lightroom menu (Mac) > Catalog Settings to confirm the location of your 

catalog. Your catalog may have a different name, but they all have *.lrcat as the extension. You may 

have created more than one catalog.

pp The catalog backups—just in case your working catalog gets corrupted.

¶¶ By default, they’re stored in a Backups folder next to the catalog.

pp The previews—standard and smart previews.

These would be rebuilt on demand as long as you have the original photos. If you have available 

backup space, backing them up would save time rebuilding them, and if you deleted your original 

photos accidentally, they may be the only copy left.

If you run a versioned backup system, which keeps additional copies each time a file changes, you 

may want to exclude the previews as they change constantly and will rapidly fill your backup hard 

drives.

Previews are stored next to the catalog as folders (Windows) or files (Mac) with a *.lrdata extension.

pp The photos—in their current folder structure, in case you ever have to restore a backup. You’ll 

want to include your edited files too.

These are stored in the location of your choice. To locate a specific folder, go to the Folders panel, 

right-click and select Show in Explorer (Windows) / Show in Finder (Mac).
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pp Mobile uploads—photos uploaded from your mobile phone or tablet using the Lightroom 

mobile app.

¶¶ Windows—C: \ Users \ [your username] \ My Pictures \ Lightroom \ Mobile Downloads.lrdata

¶¶ Mac—Macintosh HD / Users / [your username] / Pictures / Lightroom / Mobile Downloads.

lrdata

The Mobile Downloads.lrdata file is always stored in your Pictures folder, regardless of where your 

catalog and other photos are stored, but you can select an alternative location for downloaded 

photos in Preferences > Lightroom mobile.

pp Presets—includes Slideshow, Print and Web templates, Metadata presets, Export presets, etc.

¶¶ Windows—C: \ Users \ [your username] \ AppData \ Roaming \ Adobe \ Lightroom \

¶¶ Mac—Macintosh HD / Users / [your username] / Library / Application Support / Adobe / 

Lightroom /

If Preferences > Presets tab > Store presets with this catalog is checked, most presets and templates are 

stored in a Lightroom Settings folder next to your catalog.

pp Camera Raw User settings—includes Develop presets (xmp format), Develop default settings, 

Lens Profile defaults and camera-specific .dcp profiles, which are shared with ACR.

¶¶ Windows—C: \ Users \ [your username] \ AppData \ Roaming \ Adobe \ CameraRaw \

¶¶ Mac—Macintosh HD / Users / [your username] / Library / Application Support / Adobe / 

CameraRaw /

pp Custom Profiles —includes creative profiles (xmp format), which are shared with ACR.

¶¶ Windows—C:\ ProgramData \ Adobe \ CameraRaw \ Settings \

¶¶ Mac— Macintosh HD / Library / Application Support / Adobe/ CameraRaw / Settings /

pp Plug-ins—includes export plug-ins, web galleries and any other extensions that you may have 

downloaded for Lightroom. Don’t forget to keep their serial numbers safe too. These are stored in 

your choice of location. Check File menu > Plug-in Manager for the location of each plug-in.

pp Preferences—includes last used settings, view options, FTP settings for uploading web galleries, 

some plug-in settings, etc. The preferences could be rebuilt if necessary, but you may save yourself 

a little time by backing them up and restoring them.

¶¶ Windows—C: \ Users \ [your username] \ AppData \ Roaming \ Adobe \ Lightroom \ Preferences 

\ Lightroom Classic CC 7 Preferences.agprefs

¶¶ Mac—Macintosh HD / Users / [your username] / Library / Preferences / com.adobe.

LightroomClassicCC7.plist

pp Startup Preferences—includes the last used catalog path, the recent catalog list, which catalog 

to load on startup and the catalog upgrade history. The preferences could be rebuilt if necessary, 

but you may save yourself a little time by backing them up and restoring them.

¶¶ Windows—C: \ Users \ [your username] \ AppData \ Roaming \ Adobe \ Lightroom \ Preferences 

\ Lightroom Classic CC 7 Startup Preferences.agprefs

¶¶ Mac—Macintosh HD / Users / [your username] / Library / Application Support / Adobe / 

Lightroom / Preferences / Lightroom Classic CC 7 Startup Preferences.agprefs
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Once the import dialog closes, you’ll be 
viewing the main Lightroom Interface, also 
known as the Workspace, so let’s do a quick 
guided tour of the basics.  (Figure 14)

Title Bar

The Title Bar shows the name of the current 
catalog, along with the standard window 

THE LIGHTROOM 
WORKSPACE 6

Figure 14   The Lightroom Workspace or Interface.

buttons. If it goes missing, along with the 
minimize/maximize/close buttons, press 
Shift-F once or twice to cancel the Full 
Screen modes.

Identity Plate & Activity Center

The Identity Plate allows you to add your 
own branding to your catalogs. You’ll find 

Title barIdentity Plate & Activity Center

Panels

Module PickerFilter Bar

Preview AreaToolbarFilmstrip Breadcrumb Bar
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collection, the number of photos in the 
current view and the number of selected 
photos. If you click on it, there’s a list of 
recent sources for easy access. 

Module Picker

The Module Picker gives you access to the 
Library, Develop, Map, Book, Slideshow, 
Print and Web modules. The selected 
module is highlighted, and you can click on 
another module name to switch modules. 
If you right-click on a module name, you 
can hide modules from view.

Filter Bar

When viewing Grid view, the Filter Bar 
will appear above the thumbnails. It allows 
you to filter the current view to only show 
photos meeting your chosen criteria. If 
it goes missing, press the \ key on your 
keyboard. You can also access the star, color 
and flag filters by clicking the word Filter on 
the Filmstrip.

Preview Area

The central area of the screen is the Preview 
Area or main work area.

Toolbar

The Toolbar gives easy access to often used 

the settings under the Edit menu (Windows) 
/ Lightroom menu (Mac) > Identity Plate Setup. 
Click on the Identity Plate to view the 
Activity Center. (Figure 15) This displays the 
active tasks and pause buttons for some 
background tasks such as syncing and face 
recognition.

Panels

Panels can be opened and closed by clicking 
on the panel header. If you right-click on the 
panel header, you can show/hide specific 
panels. In the same right-click menu, you’ll 
also find Solo Mode, which automatically 
closes a panel when you open another panel 
in the same panel group. It’s particularly 
useful when working on a small screen. 

Show/Hide Panel Groups

The left and right hand sides are called panel 
groups. If you click on the black bars along 
the outer edges of the screen, you can show/
hide the left/right panel groups, as well as 
the Module Picker and the Filmstrip. Right-
clicking on the black bars gives additional 
options.

Breadcrumb Bar

The breadcrumb bar has controls for the 
secondary window, as well as information 
about the selected source folder or 

Figure 15   The Activity Center appears when you click on the Identity Plate.
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tools. Press T on your keyboard if it goes 
missing, and click on the arrow at the right 
hand end to choose which tools show in the 
Toolbar. (Figure 16)

Filmstrip

The Filmstrip is available in all modules and 
shows the set of photos you’re currently 
viewing. When you select a different photo 
in the Filmstrip, the main Preview Area is 
updated too.

SHORTCUTS

G = Grid view 
E = Loupe view 
C = Compare view 
N = Survey view 
Tab = Show/hide side panels 
Shift-Tab = Show/hide all panels 
Shift-F = Cycle through full screen 
modes 
T = Show/hide Toolbar 
\ = Show/hide Filter Bar

Grid

Loupe

Compare

Survey

Faces

Flags

Stars

Color Labels

Rotation

Navigation

Impromptu Slideshow

Draw Face Tool

Grid Thumbnail SizeZoom

View Options

Figure 16   The Toolbar appears below the grid or preview area, and gives 

you easy access to frequently used tools. This is the Loupe view toolbar. You 

can add additional information by clicking the arrow on the right.
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Press the J key on your keyboard three times 
to cycle through the available thumbnail cell 
styles. (Figure 19) Go to View menu > View 
Options to control the information shown on 
your thumbnail cells. (Figure 20)

When the import finishes, the Previous 
Import collection is automatically selected 
in the Catalog panel, so let’s use these newly 
imported photos to explore further. 

VIEWING YOUR PHOTOS 
IN GRID VIEW

Much of the work you’ll do in Lightroom will 
be using the Grid view. (Figure 17) 

The Grid view can be accessed by pressing 
G on the keyboard or by clicking the Grid 
view button on the Toolbar. Grid view is a 
scrolling page of thumbnails, and you can 
change the thumbnail size using the slider 
on the Toolbar. (Figure 18)

Figure 19  The simplest cell style (top) just 

shows the thumbnail photo. The compact 

cell (center) and extended cell (bottom) show 

additional information of your choice. 

VIEWING YOUR PHOTOS 7

Figure 17   The grid view displays 

a page of thumbnails.

Figure 18   Enter Grid view by 

clicking the button in the toolbar 

or by pressing the G key.
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Index Number

Index number shows 

the number of the photo 

in the current view.

Cell Border

Clicking in the cell border 

deselects all other photos.

Rotation

The Rotation arrows only 

show when you float 

over a thumbnail.

Badges

The Badges give you 

additional information 

about the settings applied 

to the photo. From left to 

right, they are: keywords, 

map location, collection 

membership, crop, Develop 

settings and social comments.

Quick Collection

The marker shows as a grey 

circle when the photo is in the 

Quick Collection. If the photo 

isn’t in the Quick Collection, 

the outline of the circle only 

appears when you hover 

over the thumbnail. Click 

to add or remove the photo 

from the Quick Collection.

Thumbnail

When dragging photos, 

drag by the thumbnail 

itself, not the cell border.

Metadata Status

The metadata status warns 

you when the file metadata 

conflicts with Lightroom’s 

metadata, or when the file 

is missing or corrupted.

Bottom Label

The information is selected 

in the View Options 

dialog. Here it shows star 

ratings and color label.

Flag

The flag state can be unpicked 

(invisible until you float 

over it), picked (white flag) 

or rejected (black flag).

Top Label

The information is selected 

in the View Options dialog. 

In this screenshot it’s set to 

‘File Name and Copy Name’.

Virtual Copy

A photo can have multiple 

versions of settings. These 

virtual copies are marked 

with a turned corner.

Stack

The Stack indicator shows 

how many photos are grouped 

together and the double 

lines show the beginning 

and end of the visible stack. 

They’re shown here on both 

sides as the stack is closed.

Sync Status

The sync status icon shows 

three dots when the file 

is waiting to be synced.

Figure 20   The thumbnails can show a variety of information.

ONE PHOTO OR ALL?

Lightroom’s Grid view behaves differently to other views—anything you do in Grid 
view on the primary monitor applies to all selected photos, whereas most other views 
only apply to the active photo (unless you have Auto Sync enabled—there’s always an 
exception!)
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deleting photos, double check how many 
photos are selected, otherwise you could 
accidentally apply a command to all of 
them. 

VIEWING YOUR PHOTOS 
IN MORE DETAIL

The thumbnails give you a good overview, 
but they’re a little too small to see the detail 
in your photos, so Lightroom offers three 
further view modes—Loupe, Compare and 
Survey—each with different strengths.

VIEWING YOUR PHOTOS 
IN LOUPE VIEW

The Loupe view shows a larger view of one 
photo at a time. (Figure 22) 

To access Loupe view, click the Loupe button 
on the Toolbar or press the E key. (Figure 23)

You can move from one photo to the next 
using the left and right arrows on the 
keyboard, the arrows on the Toolbar beneath 
the photo, or by selecting another photo 

SELECTIONS

When you select multiple photos in 
Lightroom’s Grid view or in the Filmstrip, 
you’ll notice that the cell border displays in 
three different shades of gray. (Figure 21)

Because Lightroom allows you to 
synchronize settings across multiple 
photos, there needs to be a way of 
choosing the source of the settings as well 
as the target photos, so Lightroom has 
three different levels of selection (or two 
levels of selection plus a deselected state, 
depending on how you look at it). 

•  Active—The lightest shade of gray is 
the active photo. That’s the single photo 
that’s shown in Loupe view or the Develop 
module.

•  Selected—The mid gray is also selected, 
but it isn’t the active photo.

•  Not Selected—The darkest shade of gray 
isn’t selected.

When applying settings, or especially when 

Figure 21   There are three levels 

of selection—active (left), selected 

(center) and not selected (right).

Figure 23   Enter Loupe mode 

by clicking the button on the 

toolbar or by pressing the E key.

Figure 22   Loupe view gives a detailed 

view on a single photo, allowing you 

to zoom in to check the detail.
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key. (Figure 26)

To remove a photo from the Survey view, 
click the X in corner of the photo. When you 
go back to Grid view, only the leftover photos 
are still selected, so you can mark them using 
the ranking system of your choice.

VIEWING YOUR PHOTOS 
IN COMPARE VIEW

Compare view is used to compare two 
similar photos, and unlike Survey view, it 
allows you to zoom in too. (Figure 27)

from the Filmstrip.

To zoom in to check details, press the Z key 
or Spacebar. By default, it zooms into 1:1 or 
100% view, but there are additional zoom 
ratios at the top of the Navigator panel. 
(Figure 24) To view your photo full screen, 
press the F key to toggle in and out of Full 
Screen Preview view. 

VIEWING YOUR PHOTOS 
IN SURVEY VIEW

Survey mode allows you to view multiple 
photos at the same time, so it’s particularly 
useful when you have a series of similar 
photos to narrow down to your favorites. 
(Figure 25)

Select the photos in Grid or Filmstrip. If 
they’re consecutive photos, click on the 
first photo, then hold down the Shift key 
and click on the last one. If the photos are 
scattered, hold down Ctrl (Windows) / Cmd 
(Mac) while clicking on their thumbnails. 
Once the photos are selected, press the 
Survey button on the Toolbar or press the N 

Figure 26   Enter Survey mode 

by clicking the button in the 

Toolbar or by pressing the N key.

Figure 25   Survey mode allows you to 

view multiple photos at the same time.

Figure 24   The zoom ratios are 

in the Navigator panel.

Figure 27   Compare mode compares 

two photos in great detail, choosing your 

favorite before moving onto the next pair.
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one of the folders starting with 2013.

Right-click on this top level 
folder and choose Show Parent 
Folder from the menu. (Figure 30)  
(If this option doesn’t appear in the menu, 
you’ve right-clicked on the wrong folder.)

In most cases, you’ll only need to add a 
single parent folder, but if you have a deep 
nested hierarchy, you may want to repeat 
on the new top-level folders until you can 
visualize the whole tree.

Select two photos and press the Compare 
button on the Toolbar or press the C key. 
(Figure 28)

The active photo becomes the Select, 
shown on the left and marked with a white 
diamond icon. The other photo becomes the 
Candidate, shown on the right and marked 
with a black diamond icon.

The Select on the left is fixed in place, and as 
you use the arrow keys on your keyboard to 
step through the photos, the Candidate on 
the right changes. When you find a photo 
you like better than the current Select, you 
can press the XY buttons on the Toolbar 
to switch them round, making your new 
favorite photo your new Select.

VIEWING FOLDERS IN LIGHTROOM 
AND ON THE HARD DRIVE

Using a database to catalog photos is a new 
concept to many Lightroom users, so it’s 
important to understand how the photos in 
Lightroom relate to the files on your hard 
drive.

Look at the Folders panel on the left hand 
side of the Library module. You may have 
one or more folders listed, but the folder 
structure probably won’t match your 
hierarchical folder structure in Explorer 
(Windows) or Finder (Mac). Only folders 
that hold imported photos show in the 
Folders panel.

To make it easier to visualize where the 
photos are stored on your hard drive, we 
can display the same hierarchy.

Find a top level folder. In Figure 29, this is 

Figure 28   Enter Compare mode 

by clicking the button in the 

Toolbar or by pressing the C key.

Figure 29   The initial view of the 

Folders panel may not be easy to relate 

to the folders on the hard drive.

Figure 30   Using Show Parent Folder to 

display additional parent folders into the 

Folder panel view makes it easier to visualize 

how Lightroom relates to the hard drive.
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In Figure 31, we’re still missing some parent 
folders, so we right-click on the 2013-07 
folder and choose Show Parent Folder and 
then right-click on the 2013 or 2014 folder 
to show the My Photos folder that contains 
all of the Lightroom photos. 

We could go one step further and Show 
Parent Folder on the My Photos folder to show 
the main Pictures folder too. (Figure 32)

Once you’ve finished, you can see a 
hierarchy of folders that looks much more 
like the Explorer (Windows) / Finder (Mac) 
view. (Figure 33)

Figure 33  The 

same folder 

hierarchy shown 

in Windows 

Explorer and 

Mac Finder. 

Figure 31    

In some cases, you’ll need to use Show 

Parent Folder on multiple folders.

Figure 32    

The end result of the process is a 

familiar folder hierarchy.
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Having imported and viewed your photos, 
you’ll be ready to start sorting through the 
photos. Select the Previous Import collection 
in the Catalog panel, or another folder in the 
Folders panel, and we’ll explore the options.

RATING YOUR PHOTOS

Lightroom offers three different ways of 
ranking your photos. The buttons can be 
displayed on the toolbar by clicking the 
arrow at the right-hand end. (Figure 34)

Flags have three different states—flagged 
(picked), unflagged and rejected. It’s a 
popular ranking system among Lightroom 
users, but note that flags can’t be written to 
the files or shared with other software. 

Star Ratings are used by photographers 
worldwide, with 5 stars being the best 
photos. Stars are standardized metadata so 
they can be understood by other software. 
Many photographers limit themselves to 
using 1-3 stars when initially ranking their 
photos, and leave 4 and 5 stars for the best 
photos they’ve ever taken. 

Color Labels have no specific meaning, so 

you can decide how to use them. Many use 
them to mark photos that need further 
work in other editors, for example, photos 
that need retouching in Photoshop, sets of 
photos for merging into HDR, photos to be 
built into a panorama, etc. 

If you haven’t decided which system to use 
yet, I’ve included my workflow on the next 
page. (Figure 35)

DELETING FUZZY PHOTOS

Even the best photographers sometimes 
end up with photos that aren’t worth 
keeping.

It’s possible to delete photos while you’re 

SELECTING THE BEST 
PHOTOS 8

Figure 34   Buttons for flags, star ratings and color labels can be displayed 

on the Toolbar by clicking the arrow at the right-hand end.

RATING SHORTCUTS

P = Pick flag
U = Unflag
X = Reject flag
0-5 = 0-5 stars
6-9 = Red, yellow, green & blue label
Caps Lock = auto-advance
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STEP 1

Start in Grid view with large thumbnails. It’s 

easier to make decisions when you’re not bogged 

down in the details. Just flag or reject the ones 

you really like or don’t like. Leave the rest 

unflagged.

“keep that!” “Boring...” “Ooops!”

STEP 2

Go to Photo menu > Delete 

Rejected Photos to delete 

the really bad photos from 

the hard drive.

STEP 3 

Use the Attribute Filters 

to show only Unflagged 

photos, then give them 1 

star.

STEP 4

Use the Attribute Filters to show only Flagged 

photos. Go back through the Flagged photos 

again, occasionally switching to 

Detail view to check focus.

“I LOVE 

that!”

“I like 

that!”

“It’s a bad photo but 

it sparks a memory 

or tells the story.”

STEP 5

Some months 

later, go back 

through the 

3 and 4 star 

photos and see 

if any need to 

be upgraded or downgraded. It’s easier 

to make an objective decision when 

time has passed.

RESULT Meaning What’s Next...

Really bad photo worthy 

of deletion.
Nothing (deleted)

Should be deleted really, but I’m a 

packrat. Never to be seen again!
Nothing (ignored)

Triggers a memory, but not great 

as a photo. The hotel room, a 

meal out with friends, etc.

A fast edit and a few keywords. 

They might end up in a photo book 

or slideshow, but they’ll never be 

great photos in their own right.Decent photo I’d be willing 

to show someone. 

Good photo, might end up on 

the wall or social media. 

A careful edit, possibly some Photoshop 

work, titles/captions and more extensive 

keywords. These are the photos that will 

end up on the wall or on social media.Best photos ever taken. Rare!

Figure 35   Need a tried & tested workflow for selecting your best photos? This is my personal workflow.

Rating Workflow
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be deleted, just in case you’ve accidentally 
selected photos you want to keep.

GROUPING SIMILAR 
PHOTOS USING STACKS

As you’re sorting through your photos, you 
may come across groups of photos that 
don’t mean a lot on their own. For example, 
groups of photos taken for a panorama or 
HDR often look awful as individual photos!

Lightroom offers stacking as a way to group 
these photos and display them as a single 
photo while you’re browsing.

To create a stack, select the photos and go to 
Photo menu > Stacking > Group into Stack. The 
photos automatically collapse into a stack, 
marked with double lines at the beginning 
and end. (Figure 37)

sorting through them, simply by pressing 
the Delete key on your keyboard, but it’s 
quicker to mark them with a Reject flag (X 
key) and then delete them in one go. 

Photos marked as rejects show in the Grid 
view as dimmed photos, so it’s easy to check 
that you’ve marked the right ones. When 
you’re ready to delete all of the rejected 
photos, go to Photo menu > Delete Rejected 
Photos.

Before Lightroom deletes the photos, it 
asks whether to Remove or Delete them. 
(Figure 36) Note the difference. Remove just 
removes the reference to the photo from 
Lightroom’s catalog, but the photo remains 
on the hard drive. Delete deletes the photo 
from your hard drive too (or sends them to 
the Recycle Bin/Trash if possible).

Before you select either option, double 
check the number of photos that it says will 

PHOTOS ARE NOT 
IN LIGHTROOM

Remember, photos are never IN 
Lightroom. Don’t move, rename or 
delete files or folders using Explorer/
Finder or other software after import as 
Lightroom will no longer be able to find 
them.

Figure 36   In the Delete dialog, note the difference between Remove and Delete, 

and don’t forget to check the number of photos that will be deleted.

Figure 37   Collapsed stacks 

show as a single photo.
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Removing photos from a collection is as 
simple as hitting the Delete key. When 
you’re viewing a collection, Delete only 
removes the photo from the collection, 
rather than from the catalog or hard drive.

To open the stack, click on the white number 
in the corner. The photo on the left is the 
photo that shows when you view a collapsed 
stack. (Figure 38)

If the photo that best represents the stack—
perhaps the finished panorama or the 
finished HDR photo—isn’t currently at the 
top of the stack, click on its number to move 
it to the top of the stack.

COLLECTIONS

Collections are another way of grouping 
photos. They’re similar to folders, except the 
photos don’t move on the hard drive. This 
means the same photo can be in multiple 
collections, and the photos in the collections 
can be stored in various different folders.

To create a collection, scroll down to the 
Collections panel, which you’ll find in the left 
panel group in all modules, click the + button 
at the top and select Create Collection. 
Name the collection, and it appears in the 
Collections panel. (Figure 39)

From the Grid view, select photos and drag 
them from the thumbnail preview area 
onto the collection. Don’t forget to grab 
the photos by the thumbnail itself, not the 
border surrounding it.

Figure 38   When you click on the white rectangle, the stack opens to show the group of photos.

Figure 39   To create a Collection, click the 

+ button on the Collections panel and enter 

the name in the Create Collection dialog.
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Once you’ve finished selecting your favorite 
photos, it’s time to add metadata to help you 
find them again later. Sorting through your 
photos first means you can focus your efforts 
on the best ones, which are the ones you’re 
likely to want to find again.

TITLE & CAPTION

Some photographers like to add descriptive 
text to the photos, perhaps for use as 
captions when posting to Flickr or when 
using Lightroom Web Galleery. Go to the 
Metadata panel to type directly into the 
metadata fields. (Figure 40) 

TYPES OF METADATA

EXIF data is technical information 
added by the camera at the time of 
capture. It includes camera and lens 
information such as the make and 
model, and image information such as 
the capture date/time, shutter speed, 
aperture, ISO, and pixel dimensions.

IPTC data is added by the photographer 
to describe the photo, for example, 
title, caption, keywords and the 
photographer’s name and copyright. 
There are official definitions for the 
IPTC fields, and you can view the full 
IPTC specification at the IPTC website.

The Title and Caption fields do have official 
IPTC definitions, but many photographers 
simply use Title for a short image title 
(e.g. Dogs in Snow) and Caption for a more 
descriptive paragraph (e.g. William and 

ADDING METADATA 9

Figure 40   Enter your Title and 

Caption in the Metadata panel.
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to start with. If you try to add thirty 
keywords to every photo you’ve ever taken, 
it can quickly become an overwhelming job, 
so just start with a few significant keywords 
on your best photos.

There are multiple ways to add keywords, 
so we’ll just cover two options in this Quick 
Start eBook:

Type in the Keywording panel

Select the first photo, perhaps in Loupe view, 
and go to the Keywording panel in the right 
panel group in Library. Click in the keywords 
field that says Click here to add keywords 
and type your keywords, separating them 
with a comma (,). As you start to reuse 
keywords, they’ll be suggested as you start 
typing, which helps to avoid differences in 
spelling. (Figure 41)

When you’ve finished, press the Enter key 
and your keywords appear in the Keyword 
List panel.

Create and apply keywords using the 
Keyword List panel

At the top of the Keyword List panel is a 
+ button, which is used for creating new 

Charlie are playing in the snow in the back 
garden).

KEYWORDS

Keyword Tags are text metadata used to 
describe the photo. For example, they can 
include:

•  who is in the photo (people)

•  what is in the photo (other subjects or 
objects)

•  where was the photo taken (location)

•  why was the photo taken (what’s 
happening)

•  when was the photo taken (time of day, 
season, event)

•  how was the photo taken (perhaps HDR, 
tilt-shift, panoramic)

They help you search for photos later, for 
example, searching for keywords Charlie and 
snow will show just the photos of Charlie 
playing in the snow, without having to 
search through your whole catalog.

The main aim is to be able to find the photos 
again later, so don’t go overboard, especially 

Figure 41   You can add keyword 

tags to your photos by typing them 

directly into the Keywording panel.

Figure 42   Alternatively, you can click 

the + button on the Keyword List panel to 

view the Create Keyword Tag dialog.
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MAP LOCATIONS

Lightroom’s Map module allows you to sort 
and manage your photos by location. Some 
photos, for example, those shot on mobile 
phones, automatically appear on the map as 
they include GPS metadata. Other photos 
that don’t include GPS data can be tagged by 
dragging and dropping the photo onto the 
map. It’s also possible to match the photos 
with a separate GPS Track Log.

Switch to the Map module by selecting it in 
the Module Picker at the top of the screen, 
and make sure the Filmstrip is showing at 
the bottom of the screen. (Figure 43)

On the Toolbar below the map is the Zoom 
slider, which allows you to zoom in and out 

keywords. Click the + button and enter your 
keyword in the Create Keyword Tag dialog. 
(Figure 42)

To assign your new keyword to the selected 
photo, click the square to the left of the 
keyword in the Keyword List panel, which 
adds a checkmark.

If you want to add the same keyword to 
a lot of photos, for example, you have a 
series of photos of snow, select them all in 
Grid view before typing the keyword in the 
Keywording panel or checking the checkbox 
in the Keyword List panel.

Figure 43   When you open the Map module, the Map Key overlay displays, 

covering part of the map. Hide it by clicking the X in the top right corner.
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of the map. Once you’ve zoomed in, click 
and drag the map to move it around.

To go straight to a specific location on the 
map, type the name in the Search Box at the 
top of the map. (Figure 44)

Add your photos to the map, by dragging the 
photos from the Filmstrip onto your chosen 
location. If you make a mistake, drag them 
from the Filmstrip to the correct location. 
(Figure 45)

When you drop the photos on the map, 
a yellow or orange marker appears, and 
clicking on the marker displays the photos 
at that location. (Figure 46)

Figure 44   Search for a specific location 

using the Search Box at the top of the map.

Figure 46   Click on a pin to view all of 

the photos taken at that location.

Figure 45   Drag photos from 

the Filmstrip onto the map.
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FINDING & FILTERING 
PHOTOS 10
Using the metadata automatically 
embedded by the camera, as well as the 
metadata you’ve added, you can search the 
database to easily find specific photos. 

CHANGING THE SORT ORDER

The most basic way of finding your photos 
is scrolling through the Grid view until 
you reach the photo you’re looking for. If 
you know the approximate capture date 
or filename, you can sort the photos into a 
specific order.

The Sort options are on the Toolbar in Grid 
view, including Capture Time, Filename 
and other useful options. The A>Z button 
reverses the selected sort order. (Figure 47)

USING FILTERS

Scrolling through the photos works well if 
you only have a few photos, but it becomes 
impractical as your photo library grows. 
That’s where filtering comes in—it hides 
the photos that don’t meet the criteria you 
choose. For example, you may only want to 

view the photos with 3 or more stars, or all 
of the photos taken with a specific camera, 
or the photos you’ve tagged with a specific 
keyword.

To search your whole catalog, select All 
Photographs in the Catalog panel in the left 
panel group in Library module. (Figure 48) 

The Library Filter bar is a gray bar at the top 
of the Grid view. If it’s missing, press the \ 
key.

There are three types of filter that can be 
used separately or together: Text, Attribute 
and Metadata. (Figure 49)

Let’s try some simple filters:

1.  Click on the word Attribute and then 
click on the 3rd star, highlighting it. All 
the 0, 1 and 2 star photos disappear from 
view, leaving only the 3, 4 or 5 star photos 
showing.

Figure 47   The sort order controls 

are in the Toolbar below the Grid.

Figure 48   To search the whole catalog, 

select All Photographs in the Catalog panel.
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stop meeting that criteria. For example, 
you can create a smart collection of all the 
3+ star photos, so you can quickly view 
your best work without having to go to All 
Photographs and set up a filter.

Let’s try a simple example:

1.  Press the + button on the Collections 
panel and select Create Smart Collection.

2.  Enter a name for your smart collection at 
the top of the dialog.

2.  Click on the 3rd star again, and the other 
photos reappear.

3.  Click on the red square, and only the red 
labeled photos show.

4.  Click the 2nd star, while leaving the red 
square highlighted. Now the photos with 2 
stars or greater and a red label are showing.

5.  Click on the word None to close to 
Attribute filters, and then on Metadata to 
open the Metadata filters.

6.  In the Keyword column, select a keyword 
of your choice. The other photos disappear 
from view, leaving only the photos tagged 
with that keyword.

7.  Finally, click on the word None to disable 
the filters, so you’re back where you started.

USING SMART COLLECTIONS

We talked earlier about using collections 
to manually group photos, but smart 
collections are more like saved searches 
or smart folders. They’re stored in the 
Collections panel. (Figure 50)

Photos automatically appear in a smart 
collection when they meet the criteria you 
choose, and they disappear again when they 

Figure 49   Lightroom’s Filters can be combined to find a specific photo.

Figure 50   Smart Collections are 

stored in the Collections panel.
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3.  Enter one or more rows, selecting the 
metadata type in the pop-up and the criteria 
to the right. The + button at the end of the 
row creates an additional row. For example, 
the smart collection in Figure 51 displays 
photos with the keyword dogs, shot in 2014 
on a Canon 600D  with 18-200mm lens, and 
rated as 3 stars.

4.  Press Create to finalize your smart 
collection. Your new smart collection 
appears in the Collections panel and you can 
click to view it again at any time, or double-
click to edit the criteria.

Figure 51   Smart Collections are like Saved Searches, automatically 

updating as photos meet, or stop meeting, the criteria you choose.
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One of the first things photographers want 
to do is edit their photos. Lightroom excels 
at that, so let’s explore the most frequent 
adjustments made using the Develop 
module.

BASIC ADJUSTMENTS

Most image adjustments are performed 
using the Basic panel on the right hand side 
of the Develop module. Just because there 
are a lot of sliders doesn’t mean you have to 
adjust every single one! (Figure 52)

It’s most efficient to work roughly from 
the top down, as shown on the next page. 
(Figure 53) However many times you move 
a slider, it doesn’t degrade the image quality 
because the adjustments are saved as text 
instructions and only applied to the on-
screen preview.

Let’s cover a quick summary of the sliders, 
then we’ll work on some examples.

1.  It sounds obvious, but look at the photo 
carefully first, and decide what you want 
to change. Is it too dark? Too light? Perhaps 
too yellow from indoor lighting? Has it lost 
detail in the highlights? Is it a bit flat and 
lacking contrast? Is there lens distortion? Is 
there noise? Was your sensor dusty? Does 
the blue of the sky need enhancing slightly? 
Would it look better cropped? Would it be a 
stronger photo in black & white?

If you jump straight in without analyzing the 
photo, you can spend a lot of time making 
adjustments and going in circles.

2.  Roughly fix the biggest problem first. In 
most cases, this is the exposure or the white 
balance (color) of the photo. This makes it 
easier to see what else needs to be done.            

EDITING PHOTOS 11

Figure 52   You’ll make most of your 

image adjustments using the Basic 

panel in the Develop module.
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Basic Panel Workflow

High/Normal 
Dynamic Range

Low Dynamic 
Range

Exposure always goes 

first as other sliders 

won't work well with 

incorrect Exposure

- Highlights  

+ Shadows to pull 

back highlight 

and shadow detail

+ Whites 

- Blacks to extend 

tonal range

+ Whites 

- Blacks to bring 

back contrast lost 

by the Highlights/

Shadows 

adjustments

+ Clarity and/or  

+ Contrast to bring 

back midtone 

contrast if needed

Adjust Vibrance 

/ Saturation

Ignore Highlights  

and Shadows, 

as they won't 

work well

Exception. Highlights/

Shadows add local 

contrast. In some 

cases, you might want 

the softer look of a 

tone curve instead of 

Highlights/Shadows

Exception. In some 

cases, you might want 

to use + Highlights 

and/or - Shadows to 

brighten highlights 

or crush shadows, 

especially if you’re not 

comfortable with the 

Tone Curve panel

Fine tune White 

Balance

If the White Balance is 

way off, you may need to 

fix it before continuing

Figure 53  Lightroom’s Basic panel is designed to be used top-down... mostly.

Texture if needed 

for crispness
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green, adjust the Tint slider too.

4.  Adjust the Exposure slider to set the 
overall brightness of the photo, moving to 
the right to brighten the photo or to the 
left to darken it. The easiest way to decide 
the correct exposure is to look at the little 
Navigator preview in the top left corner 
while you move the slider, so you’re not 
distracted by the content of the photo. 

5.  The Highlights and Shadows sliders affect 
the light and dark areas of the photo. If the 
light areas are lacking detail, try moving the 
Highlights slider to the left to darken them 
slightly. If the dark areas and shadows are 
lacking detail, try moving the Shadows slider 
to the right to lighten them slightly. 

6.  The Whites and Blacks sliders affect the 
clipping of the lightest and darkest tones. 
Hold down the Shift key and double-click 
on the words Whites and Blacks. This auto 
setting often does a good job with these 
sliders.

7.  The Texture slider is designed to enhance 
mid-sized details in your photo. Click on the 
photo to zoom in to 1:1 for a more accurate 
preview. Can also be used to soften skin by 
setting a negative value.

8.  Clarity adds ‘punch’ to the photos. 
Architecture and landscapes can benefit 
from higher values, but avoid using it 

If the photo’s very under or over-exposed 
(too dark or too light), adjust the Exposure 
slider to get the overall exposure in the right 
ballpark, but don’t worry about fine tuning 
yet. 

(Optional) You could try pressing the Auto 
button in the Basic panel. Sometimes it does 
a great job and other times it’s wildly wrong. 
If you don’t like the result, press Ctrl-Z 
(Windows) / Cmd-Z (Mac) to undo, or use it 
as a starting point for further adjustments.

3.  If the photo’s the wrong color, adjust the 
White Balance sliders. This compensates for 
the color of the light in which the photo was 
taken. For example, a photo taken indoors 
without flash may be too yellow.

The quickest way to set the white balance 
is to select the White Balance Selector 
tool (it looks like an eyedropper) and click 
on something that should be light gray. 
(Figure 54)

You can then go back and fine tune the white 
balance by adjusting the Temperature and 
Tint sliders. Move the Temperature slider left 
to make the photo cooler or to the right to 
make it warmer. If the photo’s too pink or 

CLIPPING WARNING

If you need to check whether you’re 
losing highlight or shadow detail, turn 
on the clipping warnings by clicking 
the triangles in the top left and right 
corners of the histogram or by pressing 
J. Clipped blacks show in blue and 
clipped whites show in red.

Figure 54   Select the White Balance Selector 

from the Basic panel and click on something 

that should be neutral to correct a color cast.
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on portraits, as it accentuates lines and 
wrinkles.

9.  Dehaze is designed to remove (or add) 
haze over a landscape.

10.  The Contrast slider is last. Does the 
photo still look a little flat and muddy? Try 
increasing the contrast by moving the slider 
to the right.

11.  If the colors in your photo are a little dull, 
try increasing the Vibrance slider. It adjusts 
how saturated or colorful your photo 
appear, and it’s more intelligent than the 
Saturation slider. 

Let’s try an example… 

WHY DO MY RAW FILES NOT LOOK LIKE THEY DID ON MY CAMERA?

Raw files are unprocessed sensor data, so the raw converter has to convert the raw data 
into an image. 

The camera manufacturers, and different raw processors, have their own interpretation 
of the raw data. There is no right or wrong—it’s just different.

If you prefer the camera manufacturer’s rendering, Lightroom ships with emulation 
profiles for many cameras, which makes Lightroom’s rendering look more like the 
camera manufacturer’s rendering. If your camera has emulation profiles, you’ll find them 
under Profile at the top of the Develop panel. Select your chosen profile before making 
other Develop adjustments, as they will change the appearance.

1.  Start by analyzing the photo. The 
coastline’s too dark, but if we just increase 
Exposure, we’ll blow out the sky. (Figure 55)

2.  We’ll use Highlights -100 to recover and 
enhance the detail in the sky, and Shadows 
+80 to bring out detail in rocks and houses. 

3.  These adjustments have compressed the 
tonal range, so let’s pull the histogram back 
to the ends. We’ll use Whites +17, so the sun 
is just short of clipping, and Blacks -40, which 
blocks the darkest shadows in the rocks. I’m 
willing to sacrifice the detail in those rocks 
to increase the overall contrast. (Figure 56)

4.  Clarity +100 is an unusually extreme Figure 55  Start by analyzing the photo.

Figure 56   The Highlights, Shadows, 

Whites and Blacks adjustments bring out 

the detail, but the photo looks very flat.



41 

added Texture +40 to bring out additional 
detail too.

5.  Next, we’ll push Saturation to +100 to 
make it much more colorful. Vibrance would 
have enhanced the blues on the building 
and protected the yellows, whereas I want 
to pump up the yellow tones. Increasing 
the Saturation before the white balance will 
help me set the Temp & Tint sliders to taste. 
(Figure 57)

6.  The photo is still quite cold, and this was 
shot at sunset, so we’ll warm it up from Temp 
4850 and Tint +13 to Temp 5450 and Tint 
+18. (Figure 58)

7.  Finally, it’s still a little flat and dark, 
and we can afford to sacrifice some of the 
highlight and shadow detail, so we’ll bump 
Contrast to +40 and Exposure to +0.30 to 
finish. (Figure 59)

adjustment, but the photo is just flat and 
boring, and using too much Contrast would 
lose the detail in the sky and rocks. We 

Figure 59   A increase of Contrast 

and Exposure finishes it off.

Figure 58   Using the White Balance controls 

to warm the photo enhances the sunset vibe.

Figure 57   To bring back some punch, 

we’ve used Clarity and Saturation.

UNDOING EXPERIMENTS

Because Lightroom’s non-destructive, you 
can easily undo any of the adjustments.

As in most programs, Ctrl-Z (Windows) / 
Cmd-Z (Mac) is the Undo command. When 
pressed repeatedly, it steps back through 
your recent actions, whether that’s slider 
movements, star ratings, or simply switching 
between modules.

Lightroom also keeps a record of all the 
Develop changes made to each photo. You 
can see this list in the History panel on the 
left in the Develop module. (Figure 60)

To go back to an earlier version, click on an 
earlier history state in the History panel. If 
you make further changes, Lightroom will 
continue recording from that point.

Finally, if you don’t like the results of your 
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Lightroom doesn’t need to duplicate the 
original image file.

To create a virtual copy, right-click and 
choose Create Virtual Copy. An additional 
copy appears next to the master (original 
file), and it has a small triangle in the corner 
of the thumbnail, indicating that it’s a virtual 
copy. (Figure 62)

If you no longer want a virtual copy, you 
can delete it like any other photo. Deleting 
a virtual copy won’t remove the original 
photo from the hard drive—only a master 
can do that. It just removes that version of 
the photo’s settings.

CROPPING & STRAIGHTENING

Most photos benefit from cropping, whether 
to remove distracting objects, straighten 
horizons, for artistic effect, or simply to fit 
your chosen ratio.

Figure 62   Virtual copies can be 

identified by the triangular icon in 

the corner of the thumbnail.

Figure 61   Before/After view 

options appear in the Toolbar.

Figure 60   The History panel records 

the changes you make in the Develop 

module, as well as exports.

experiment and want to start again, you 
can press the Reset button at the bottom of 
the right hand panels to reset the photo’s 
settings back to their default.

BEFORE/AFTER PREVIEW

Once you’ve edited your photos, you’ll 
want to see the results of your hard work. 
The Before/After Preview allows you to 
compare your current Develop settings with 
an earlier version, using your current crop 
settings.

Press the \ key to toggle back and forth 
between before/after, or the Y key to see 
them side-by-side. The Y button on the 
Toolbar offers further options. (Figure 61)

VIRTUAL COPIES

If you want to experiment with different 
settings, without overwriting your current 
version, you can create a virtual copy. 
Virtual copies show up in Lightroom as 
duplicate photos, and they have their own 
metadata and settings. They don’t take up 
much more space on your hard drive as 
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To open the Crop tool, select the first icon in 
the Develop Tool Strip below the Histogram 
or press the R key. The Crop Options display 
below. (Figure 63)

First, straighten your horizon by pressing 
the Auto button. If that doesn’t work well, 
select the Angle tool in the Crop Options 
panel, and click and drag a line along the 
horizon. Lightroom automatically rotates 
the photo to make it horizontal. (Figure 64)

If you’re planning on printing the photo, 
you may want to restrict your crop to a 
standard ratio. As Lightroom never throws 
away pixels, it doesn’t crop to a specific 
size—just a ratio. This enables you to reuse 
the same crop for multiple different sizes, 
for example, a 4x5 crop can be output as 
800x1000 pixels, 4”x5”, 8”x10”. Select the 

ratio in the Crop Options panel, and choose 
the size when you export the photo. For a 
free-form or non-standard crop ratio, leave 
the Lock icon unlocked.

To switch the orientation, for example, 
to make a vertical crop from a horizontal 
photo, press the X key.

Adjust the crop by dragging the corners or 
the edges of the bounding box.

Move the photo around under the crop 
overlay by clicking within the bounding box 
and dragging the photo into position. Rotate 
the photo by clicking and dragging around 
the outside of the bounding box. Think of it 
as moving the photo underneath the crop 
overlay, rather than moving the crop.

Once you’ve finished cropping, press the 
Enter key or the Done button on the Toolbar.

SHARPENING

Your photos may need a little sharpening, so 
zoom into 1:1 view by clicking the 1:1 icon 
on the top of the Navigator panel. Other 
zoom ratios won’t be as accurate.

In the Sharpening section of the Detail panel 
(Figure 65), the Amount slider controls the 
amount of sharpening applied. By default, 
that’s set to 0 for JPEGs as they may have 
been sharpened by the camera. Raw files are 
set to 40 by default.

The default settings are an excellent starting 
point and you may be satisfied with these 
settings. For more content-specific settings, 
there are a couple of sharpening presets for 
faces and landscapes in the Presets panel.

Be careful not to oversharpen, as you can 
also apply output sharpening when you 
come to export the photos later.

Figure 63   To open the Crop tool, 

select the first icon in the Tool Strip. 

The options appear below.

Figure 64   Straighten the photo 

by selecting the Angle tool and 

dragging a line along the horizon.
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FIXING NOISY PHOTOS

Noise (similar to grain) in your photos can 
be very distracting. You’ll particularly notice 
it in photos shot at high ISO, for example, 
shot without flash in a darkened room. If 
you’ve increased the exposure considerably 
within Lightroom, it can also increase 
the appearance of noise. Fortunately, 
Lightroom’s Noise Reduction tools are 
excellent.

In the Detail panel, there are a range of noise 
reduction sliders for extreme cases, but 
you’ll usually only need to adjust Luminance 
and perhaps Color. As with sharpening, 
zoom into 1:1 view as other zoom’s aren’t as 
accurate. (Figure 75)

If you’re working on raw files, try a setting 

of around 15-20 Luminance as a starting 
point. That will reduce the noise in most 
cases, without losing too much image detail. 
The aim is to reduce the noise, rather than 
making the subject look like plastic, so don’t 
push it too far. JPEGs may have already had 
some noise reduction applied by the camera, 
so you’ll need a lower value for these.

The Color slider is set to 25 by default for 
raw files, which is usually plenty. It’s set to 
0 by default for JPEGs, but if there’s still 
colored noise in your photo, particularly in 
the dark shadows, try increasing it slightly.

FIXING DISTORTION

Your photos may be distorted, either 
because of defects in the lens itself or 
because of the shooting angle. Applying lens 
and perspective corrections in Lightroom’s 
as simple as checking the checkboxes in the 
Profile tab of the Lens Corrections panel. 
(Figure 66)

The Enable Profile Corrections checkbox 
applies the lens profile. If the photo doesn’t 
change, select the correct lens profile from 
the Make, Model and Profile pop-ups. 

Many recent cameras, such as compact 
and mirrorless cameras, have lens profile 
information embedded in the raw file and 
applied automatically by Lightroom. At the 
bottom of the Profile tab, if it says Built-in 
Lens Profile applied, click on the i button 
to view additional information about the 
automatic fixes.

The Remove Chromatic Aberration 
checkbox removes any fringing in the 
photo, particularly around high-contrast 
edges or in the corners of the photo. It’s 
not enabled by default as it can have a 
slight performance hit and soften the photo 
very slightly, but it’s an easy fix if there is 

Figure 65   Sharpening and Noise Reduction 

are applied using the Detail panel.
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Lightroom creates a basic black & white 
photo, which you can then fine tune by 
adjusting the way the colors are mixed and 
tweaking the contrast. 

Go to the B&W panel and click on the 
Targeted Adjustment Tool in the top left 
corner to select it. The Targeted Adjustment 
Tool—or TAT Tool, for short—allows you to 
adjust the B&W mix by dragging directly on 
the photo while it figures out which sliders 
to move. (Figure 68)

Find an area of the photo that you’d like to 
be darker—perhaps the blue sky—and click 
and drag down on that area. As you drag, the 
blue tones get darker and the sliders in the 
B&W panel move. Find another color in the 
photo that you’d like to be lighter—perhaps 
something red—and as you click and drag up 
the red tones lighten.

You may also want to adjust the contrast 
of the photo using the Basic or Tone Curve 
panels, to better suit the B&W version. 

fringing in your photo.

Finally, you can press the Upright Auto 
button in the Transform panel to apply 
automatic perspective adjustments. Most 
of the time, Auto is the best choice, but you 
can try the other Upright buttons to see if 
you prefer the result.

CONVERTING PHOTOS 
TO BLACK & WHITE

Converting your photo to black and white is 
very simple—just press the V key or select 
Black & White at the top of the Basic panel. 
(Figure 67)

Figure 66   Lens and perspective 

corrections are found in the Lens 

Corrections and Transform panels.

Figure 68   Fine tune the B&W 

mix using the B&W panel.

Figure 67   Convert to black and white using 

the button at the top of the Basic panel.
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COPYING SETTINGS TO 
SIMILAR PHOTOS

Lightroom is a workflow tool, so it’s 
designed to work with multiple photos. If 
you shoot a series of photos in very similar 
light, you may want to copy settings from 
one photo to other similar photos. There are 
multiple ways to do that, but here are two…

Sync

Sync uses the data from the active (lightest 
gray) photo, and pastes it onto the other 
selected (mid-gray) photos. This is why 
there are three different levels of selection.

1.  Adjust the first photo, which is the source 
of the settings.

2.  Keeping this photo active, also select 
the other photos by holding down Ctrl 
(Windows) / Cmd (Mac) or Shift and clicking 
directly on their thumbnails, rather than the 
cell borders.

3.  Click the Sync button in the Develop 
module, or Sync Settings in the Library 
module, to show the Sync Develop Settings 
dialog. (Figure 69)

4.  Select the checkboxes for the slider 
settings that you want to copy to the other 

selected photos, and then press Synchronize 
to transfer the settings.

Copy and Paste

Copy and Paste allows you to copy settings 
into memory, and then paste them onto 
individual photos.

1.	 Adjust the first photo, which is the 
source of your settings.

2.	 Click the Copy button in the Develop 
module. (Figure 70)

3.	 Select the checkboxes for the slider 
settings that you want to copy.

4.	 Press the arrow key on your keyboard 
to move to the next photo, or select a 
different photo in the Filmstrip.

5.	 Click the Paste button to paste these 
settings onto the selected photo.

You don’t have to copy all of the settings. 
Sync and Copy/Paste both have dialogs 
allowing you to choose specific settings 
to transfer, so you may just sync Noise 
Reduction or White Balance, for example, 
without copying the Exposure settings.

SAVING SETTINGS TO APPLY 
TO OTHER PHOTOS

Presets save sets of settings to apply to 
other photos over and over again. They 
simply move sliders to preset positions. 
Some sample presets ship with Lightroom, 
and you can create your own presets using 
your favorite settings. 

To apply a preset, go to the Presets panel on 
the left in Develop. (Figure 71) As you float 
over the preset names, a preview displays in 
the Navigator panel above. Simply click on 

Figure 69   Sync is at the bottom of the 

right panel group in the Develop module.

Figure 70   Copy and Paste are at the 

bottom of the left panel group.
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the preset name.

A whole community has sprung up, sharing 
and selling Lightroom Develop presets. They 
can offer a good starting point for your post-
processing, or more frequently, some weird 
and wonderful effects. 

If you’re installing presets from a single 
folder, the automatic method is quick and 
easy. 

1.  Unzip the presets if they’re zipped.

2.  Go to Develop module Presets panel, 
right-click the User Presets folder and choose 
Import.

3.  Navigate to the folder of presets, select 
them and press the Import button.

REMOVING DUST SPOTS

Lightroom’s Spot Removal tool isn’t intended 
to replace Photoshop or other pixel editors, 
but it allows you to quickly remove dust 
spots and other small distractions.

Select the second icon in the Tool Strip 
beneath the Histogram, or press the Q key. 

Adjust the brush size using the slider in the 
Options panel (Figure 72) and then click 
on the spot in the photo, or click and drag 
to remove a line or non-circular shape. 
Lightroom will automatically try to find a 
good source, but you can then click and 
drag the circles to fine tune the correction. 
(Figures 73-75)

To delete a spot correction, hold down 
the Alt key (Windows) / Opt key (Mac) to 
change the cursor into a pair of scissors, and 
then click on the spot again.

MAKING LOCAL ADJUSTMENTS

Most of Lightroom’s sliders apply to the 
whole photo, but the local adjustment tools 
allow you to apply settings to specific areas, 
either using a gradient or a brush.

The linear (or straight) Graduated Filter is 
particularly useful for darkening the sky in a 
sunset photo, but it can also be useful if the 
lighting on one side of the photo is different 
to the other side. Let’s try it...

1.  Select the Linear Graduated Filter—the 

Figure 71   When you float the mouse 

over a preset name, it’s previewed 

in the Navigator panel above.
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You can go back and change the settings 
later.

3.  Click on the photo and drag to create 
your gradient, for example, drag from the 
top down to darken the sky.

4.  Lines appear on screen, showing the 
limits of the gradient. The outer lines 
show where the gradient starts and stops. 
(Figure 76) Drag the lines to increase or 
decrease the range. The center line rotates 
the gradient.

5.  Once you’re happy with the gradient, you 
can fine tune the sliders in the Options panel 
to get the effect you desire. (Figure 77)

The same principle applies for the Radial 
Graduated Filter, except that creates a 
circular or oval gradient.

The Adjustment Brush allows you to paint 
on the photo, perhaps to lighten dark 
shadows, sharpen eyes, or apply a different 
white balance to a specific area of the photo. 
(Figure 78)

1.  Select the Adjustment Brush—the sixth 
icon—in the Tool Strip.

fourth icon—in the Tool Strip, just below the 
Histogram. 

2.  In the Options section below, select the 
settings that you want to apply selectively. 
It can help to select more extreme settings 
when creating the gradient, for example, 
Exposure +1, so you can easily see the effect. 

Figure 72   Select the Spot Removal tool 

from the Tool Strip under the histogram.

Figure 73   Find a spot or distraction 

in the photo, such as this piece 

of seaweed on the sand.

Figure 74   Click and drag to 

paint over the distraction.

Figure 75   Lightroom finds some new pixels 

to cover the distraction, but you can click and 

drag that overlay to choose a different source.

Figure 76   The Graduated Filter is ideal for 

darkening skies. The central line rotates and 

the outer lines show the limits of the gradient.
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The presets just move the sliders to specific 
values, but they can be helpful if you’re not 
sure which sliders to adjust. For example, 
the Teeth Whitening preset increases the 
exposure to lighten the teeth and reduces 
saturation to desaturate the yellow.

3.  Select your brush size at the bottom of 
the Options panel.

4.  Click and drag on the photo to paint your 
brush strokes. If you make a mistake, hold 
down the Alt key (Windows) / Opt key (Mac) 
to turn the brush into an eraser, and click 
and drag over the mistake to remove the 
brush stroke.

You can create more than one local 
adjustment on each photo. The local 
adjustments will be marked with pins, 
which are small gray circles. When a pin is 
selected, it has a black center, showing that 
you can edit the settings or delete the whole 
adjustment.

When you’ve finished making local 
adjustments, press the Done button on the 
Toolbar or click the icon in the Tool Strip to 
close the tool.

2.  Select your chosen slider values in the 
Options panel below. As with the Graduated 
and Radial Filters, you can go back and fine 
tune these settings later.

There’s a selection of presets in the Effect 
pop-up to help you get started. These 
include basic presets for each of the sliders, 
plus presets for Burn (darken), Dodge (lighten), 
Iris Enhance, Soften Skin and Teeth Whitening.

Figure 77   The Graduated Filter, Radial Filter 

and Adjustment Brush are the fourth, fifth and 

sixth tools in the Tool Strip under the histogram.

Figure 78   The side of the lion’s face is 

in shadow, so we can use the Adjustment 

Brush to selectively lighten that area. The 

red Mask Overlay shows the brush strokes, 

and can be turned on and off using the 

O key or the checkbox in the Toolbar.
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SHORTCUTS

Q = Spot Removal
M = Graduated Filter
Shift-M = Radial Filter
K = Adjustment Brush
Delete = Delete selected local 
adjustment or spot
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FURTHER EDITING IN 
OTHER PROGRAMS 12
Lightroom is a brilliant workflow tool, but 
there are still some tasks, such as detailed 
retouching, that require a pixel editor such as 
Photoshop. Lightroom can pass your edited 
photo over to your pixel editor and add the 
edited photo back into the catalog.

INTEGRATION WITH PHOTOSHOP

If a full version of Photoshop is installed on 
your computer, it appears in Photo menu > 
Edit In or the right-click menu. You can also 
press Ctrl-E (Windows) / Cmd-E (Mac) to 
open the photo into Photoshop. (Figure 79)

If the photo is a raw file, Lightroom opens 
the photo directly into Photoshop. If you’re 

working with a JPEG, TIFF, PSD or PNG 
file, a dialog appears asking how to handle 
the file. Select Edit a Copy with Lightroom 
Adjustments to open your photo with your 
Develop adjustments applied. (Figure 80)

Once you’ve finished editing the photo in 
Photoshop, go to the File menu > Save (not 
Save As) and then close the photo and switch 
back to Lightroom. Your edited photo is 
updated in your catalog automatically.

Figure 79   Lightroom can pass your photos to Photoshop and other external pixel editors.
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OPENING PHOTOS IN 
OTHER EDITORS

Lightroom can also send files to other 
external editors, such as OnOne software, 
Nik software, Pixelmator or PaintShop Pro.

Many of these editors come with their own 
Lightroom plug-ins and presets which are 
installed automatically. To open a photo 
in your external editor, select it under the 
Photo menu > Edit In or in the right-click 
menus. 

Editors that use plugins are found under 
Photo menu > Plugins.

Figure 80   If you open a JPEG, TIFF, PSD or 

PNG file into Photoshop, or any file format 

into other non-Adobe editors, Lightroom asks 

whether to send the original file or apply 

your adjustments to a copy of the file.
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‘SAVE AS’ A COPY ON 
THE HARD DRIVE

To export your finished photos, select them 
and then go to File menu > Export or press the 
Export button at the bottom of the left panel 
group in Library module. These are the main 
settings you’ll need to check: (Figure 81)

1.  Export Location—choose the destination 
folder for the exported photos.

2.  File Name—you can rename on export, for 
example, creating a template for Sequence 
#(001)-Filename will put a sequence number 
before your existing filename to ensure that 
they sort correctly in other software.

3.  File Format—JPEG is an excellent choice 
for web, email, etc. You’ll need to select 

Having done all this work, you’ll want people 
to see your photos, whether that’s on your 
screen, on their own computers, or even 
as prints, so let’s explore Lightroom’s most 
frequently used output options.

Lightroom is non-destructive, which means 
that it doesn’t save over your original image 
data. To apply your settings to the photo, 
you use Export, which is like a Save As in 
other programs.

When you export photos, it’s usually for a 
specific purpose, such as posting on the web, 
giving them to someone else, or sending 
them away to be printed. Most exports can 
be deleted after use, as the photos can be 
exported again in future, using the original 
image and the settings saved in the catalog.

SAVING FINISHED 
PHOTOS 13

EXPORT SETTINGS

If you’re just starting out, here are some sample export settings for different uses:

Email—Longest Edge 800px, and you can ignore the resolution as we’re specifying the 
size in pixels. Format JPEG, quality 65. sRGB.

4” x 6” digital print—Dimensions 4” x 6” at 300ppi. Format JPEG, quality 80. sRGB.

8” x 10” digital print—Dimensions 8” x 10” at 300ppi. Format JPEG, quality 80. sRGB.

Full resolution master—uncheck the Resize to Fit checkbox. Format TIFF/PSD as 
ProPhotoRGB or JPEG quality 90-100 as AdobeRGB.
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Figure 81   Use Export to create copies of your 

photos with your adjustments applied.

Export 

Location

File Name

File Format

Color Space

Size

Output 

Sharpening

a quality setting. TIFF is best for pixel 
editors such as Photoshop. Original format 
is a duplicate of the original photo, with 
extra metadata, but without your Develop 
adjustments applied.

4.  Color Space—Lightroom offers a choice 
of different color spaces when you output 
photos. Large color spaces (ProPhoto RGB 
and Adobe RGB) retain the most data, so 
they’re used when transferring photos to 

Photoshop, but they’ll look odd in programs 
that aren’t color managed, such as web 
browsers. Use sRGB for screen output, 
emailing or uploading to the web.

5.  Image Size—refers to the pixel 
dimensions of the photo. 

6.  Output Sharpening—select Screen for 
screen/web use, and the type of paper for 
prints.
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IMAGE SIZE & RESOLUTION

When digital photographers speak of 
image size, they’re usually referring to 
the pixel dimensions—the total number 
of pixels along a photo’s width and height. 
For example, an uncropped file from an 
18 megapixel camera may be 5184 x 3456 
pixels.

Pixels don’t have a fixed size. They expand 
or contract to fill the space. If you expand 
them too much, the photo appears blurry 
and pixelated (you can see the squares), so 
the aim is to keep the pixels smaller than or 
equal to the monitor pixels or printer dots. 
(Figure 82)

Resolution—for example, 300 pixels per 
inch (PPI)—only comes into effect when you 
combine it with a physical size such as 4” x 
6”.

EMAILING YOUR PHOTOS

Lightroom makes it easy to email your photos. 
Select the photos and then go to File menu > 
Email Photos.

If your default email client is supported, 
such as Outlook or Apple Mail, Lightroom 
displays the Email dialog. (Figure 83) Select 

Figure 83   The Email dialog allows you to create an email with the photos automatically 

attached. Set the image size using the pop-up in the bottom left corner.

Figure 82   Photos that are too low 

resolution appear pixelated.
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the photo size using the preset in the 
bottom left corner. If you leave the address 
and the rest of the email blank and press 
Send, it’ll open the email message into your 
email software so you can access your 
address book. Alternatively you can type 
your email into the Email dialog and send it 
directly.

If you use webmail or an unsupported email 
client, Lightroom first asks for your email 
account settings. (Figure 84)

Once your email account is set up, you can 
enter the recipient’s email address and 
your message into the Email dialog before 
pressing Send.

Figure 84   If your default email 

client isn’t supported, Lightroom 

asks for your server details.
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Setup dialog. (Figure 85)

4.  In the Layout Style panel at the top of 
the right panel group, select Single Image/
Contact Sheet. (Figure 86)

5.  In the Image Settings panel, check Zoom 
to Fill and Rotate to Fit. This fills the cell with 
the photo.

6.  In the Layout panel, set all the Margins 
to 0 for borderless printing. If they won’t 
go down to 0, the Page Setup isn’t set 
to borderless or your printer can’t print 
borderless, in which case you’ll need to use 
a larger piece of paper and cut it down after 
printing.

7.  Still in the Layout panel, set the Rows and 
Columns sliders to 1 to place a single photo 

If you’re sending your photos to an online 
lab to be printed, turn back to page 53 
and export JPEGs to send away, but if you’re 
printing to a locally attached printer, such 
as an inkjet printer, you can use Lightroom’s 
Print module to print your photos. 
Let’s create a simple 4”x6” borderless 
print (assuming your printer can print 
borderless!)

1.  Select the photo or photos you want to 
print, and then switch to the Print module 
using the Module Picker at the top of the 
screen.

2.  At the bottom of the left panel group, 
click the Page Setup button to display your 
printer’s dialog. (The options vary depending 
on the operating system and printer.)

3.  Select your paper size, for example, if 
you’re using 4x6 borderless paper, you’ll 
need to select the 4” x 6” borderless setting. 
The dialog varies depending on your printer 
driver and operating system. Close the Page 

PRINTING YOUR 
PHOTOS 14

Figure 85   Select a borderless print 

size in the Page Setup dialog.

Figure 86   Select your Layout 

Style to Single Image.
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on the page, and set the Cell Size to 6x4 for a 
6” x 4” print. (Figure 87)

8.  In the Toolbar underneath the preview, 
choose Selected Photos from the Use pop-up 
to print the selected photo(s) or All Filmstrip 
Photos to print all of them. Try a single 
print to double check your settings before 
printing a large number of photos.

9.  Scroll down to the Print Job panel. 
(Figure 88) As a default, set the Print 
Resolution field to 360ppi for Epson or 
300ppi for Canon/HP.

10.  Enable the Print Sharpening checkbox, 
selecting the amount in the first pop-up 
(Low, Standard or High) and the paper type 
(Glossy/Matte) in the second pop-up. If in 
doubt, select Standard Glossy.

11.  If you have a profile for your printer, 
select Other from the Color Management 
Profile pop-up and choose the profile. Press 
OK and select the profile in the pop-up. 

Figure 87   Set the page size and 

margins using the Layout panel.

Figure 88   Set the resolution, sharpening and 

color management in the Print Job panel.

If you don’t have a profile, select Managed by 
Printer so that the printer cares for the color 
management.

12.  Press the Printer button to view the 
Print dialog. Like the Page Setup dialog, this 
dialog varies depending on the operating 
system and printer driver. If you’re using a 
Mac, you may need to press the Show Details 
button to access the printer driver options. 
(Figure 89)

13.  Select your paper type, quality settings 
and any other settings specific to your 
printer driver. (If these options aren’t 
available, ensure that you’ve installed the 
printer driver direct from the manufacturer 
rather than the default driver provided by 
the operating system.) If you’ve selected a 
profile in the Color Management Profile pop-
up, select No Color Adjustment or ColorSync 
in the printer dialog.

14.  Finally, press Print and wait!
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Figure 89   After setting up 

the print layout in Lightroom, 

press the Printer button and 

select the correct paper and 

quality settings. The dialog may 

vary depending your printer 

driver and operating system.



60 ADOBE LIGHTROOM CLASSIC - QUICK START GUIDE

There’s additional information on how to 
optimize Lightroom’s performance, and how 
to sync with the Lightroom cloud.

The book’s available in PDF, ePub, 
Kindle and paperback formats from 
https://www.lightroomqueen.com, and the 
paperback is also available from bookstores 
such as Amazon. 

Lightroom is a vast program, with lots to 
learn, so this is just the start of your journey. 
There’s a friendly community surrounding 
Lightroom, who are ready to help you learn. 
Come and join us on the Lightroom Queen 
forums.

All of the information you’ll ever need can 
be found in my main book, Adobe Photoshop 
Lightroom Classic - The Missing FAQ, which is 
available in eBook and paperback formats.

If you’re just getting started, the Fast Track 
weaves its way through the book, with short 
tutorials that guide you through a simple 
workflow, allowing you to gain confidence 
before diving into the more advanced 
questions. You’ve sampled some of these 
Fast Track tutorials in this Quick Start 
eBook.

The rest of the book is designed as a 
conversational FAQ-style reference book, 
giving you the detailed information you need 
to make informed choices, whether you’ve 
been using Lightroom for a few months 
or a few years. No more pressing buttons 
without understanding the repercussions!

Unlike most other Lightroom books, my 
book doesn’t just talk about the theory of 
how Lightroom’s supposed to work, but 
also the workarounds and solutions for the 
times when it doesn’t behave the way you’d 
expect, and how to fix problems when you 
make mistakes.

YOU’RE OFF TO A 
GREAT START! 15

https://www.lightroomqueen.com
https://www.lightroomqueen.com/community/
https://www.lightroomqueen.com/community/
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